Real Estate Aszessment Center - Hetscape
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REAC TOPICS
what's new
about reac

directory
resource library

secure connection

HOME SEARCH/INDEX COMMENTS LIBRARY REAC HOME

Real Estate Assessment Center

“daseasments Today for Better Housing Tomorrow”

WHAT'S NEW

Submissgion and Extension Reguests
REAC is Technology Award Winner |
Ehysical Candition Stds. and Physical Inspection Beq.; Proposed Rules

frequently asked questions  Frequently Asked Questions Now on Praduct Pages

HIGHLIGHTS

I order to wiew the documents, a PDOF Reader is required

HUD's husiness patners need to register to access the EUD Systermn (Secure Connection)
An imporant messade to Multifamily Housing Project © s

HUD Inspection Contractor Planning Schedules (Contractars only)

Federal Redister Announcements

REAC PRODUCT PAGES

Financial Azsessment (FASE) Multifamily and PIHFHA
Fhysical Inspection (PASS)

Resident Service and Satisfaction Survey (RASS)
Single Family Appraisals (SASS)

Management Assessment (MASS)

Tenant Incame Wetification (TASS

REAC ON-LINE SYSTEMS
Submit an Annual Financial Statement - Multifarmily

The following REAC Tenant Income Verification screen provides a prompt box for the

| hittpe Ao hud, gov/reac/apply_message. himl SR e e |

coordinator or user to enter a User Name and Password.
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HOME SEARCH/INDEX COMMENTS LIBRARY REAC HOME

REAC Tenant Income Verification

“Assessmments Today for Belter Howsing Tormorrow”

What's New
Tenant Income Verificatia Username and Password Required
Tenant Income Yerification ; pntal assistance
administrators. Al rantal 5 Enter usemame for Enterprise Server at passward which will
provide therr with access - udapps.hud.gov: their own housing
agency ar property.

Uger Wame: |M11111
What's the Tenant Incormi. ~~ —— [“\\S
What is Tenant Incame e Fassword | atching tool used to
werify public housing and £ caomes. Want to know

maore? Ok, I Canhcel

Why use Tenant Income Verification ?
Income werification benefits low-income families, rental assistance administrators, HUD, and you the tax
paver. Find out how this benefits vou.

Wark On-Line to Access Tenant Assessment Subsystem.

Last revised: Movemnber 20, 1909

Send comments or questions to Customer Service Center Dawid L. Oecher

| == B | Connect: Please enter password for host. SleaE SE AR Fal oA |

In the fields provided, the user should enter the Secure Systems ID in the User Name Field
and the password in the Password field. The Coordinator or User can contact the REAC
Hotline at 1-800-366-0827, Option 8 for assstance in logging in.  When the Coordinator or
User sngle clicks the *OK™ button, a Security Information message box opens, as shown in
the next screen.

(If the security option is not selected in the Internet browser being used, the Security Information
message box below will not open. In this Situation, the Secure Systems page will open immediatdly.)
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|1 ] || Sem&gst%a S
™
B e

Legal Warning

Misuse of Federal Information through the HUD Secure

Connection web site falls under the provisions of title 18, ls
United States Code, Section 1030, This law specifies

penalties for exceeding authorized access, alterations,

damage, or destruction of information residing on Federal
Computers.

Continue |

2 A\

1 I
N Back to Top)|
Home

l_ [ |Document: Done 1k 7
ﬁSlaltl !»Attache I NoteTab |@Quer}l b.. I@Explonng ”ﬁSecure B Microsoft .. ||fﬁ:|8nag|t.f3 I E&QQ. 1

After reading the legd warning, the user sngle clicks the “ Continue” button. The following
Secure Systems page will open, as shown in the next screen.  This screen ligs the system
project headings of specific systems to which the Coordinator or User logging in has access.

Different Coordinators or Users will have different systems available, depending on the rights
assigned to their ID.
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US, Drept. of Housing

and Urban Development &?ﬂgm

Seenre-Systems =

HUD

*! }*

+ Tenant Fental Assistance Certification Systetn (TRACS)
+ Resident Assesstnent Subsystem (RASS)
¢ Tenant Assessment Subsystem (TASS)

System A dministration - Guide

User Group Maintenance

Uzer 1D Waintenance

Property Assigntment Maintenance

Business Partners Maintenatnce

Assistance Contract Assignment IWaintenance

Password Change

4 Py

S 1 I
Eack to Top)
Home ]
-
| 3

4
|3 == {Document: Dane El_‘ii% T, A vl
Eiﬁtartl !»Attache...l NoteTab...I @Query-M...l @Exploring...”ﬁﬁecure_._ EYMicmsofl...I fi@R Snaglts3... | |$ H[Q® 153pM

When the Coordinator or User clicks on the “ Tenant Assessment Subsystem” link, the Welcome to
the TASS - Tenant Assessment Subsystem Internet Reporting Facility will be presented. The
screen will prompt the Coodinator or User to select an option from the list. The next screen
provides a sample report status of when the reports were loaded.
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Welcome to TASS

Tenant Assessment Subsystem
Internet Reporting Facilily

Please select an option frorr]:the list belowr.

+ Wiew TASS Reports

TASS Internet Facility News

Report Status:
Reports Last Loaded on August 23, 1999 for recertifications due December, 1999

By == | Dacument: Done SR TS ) 2|
Eﬁﬁtartl g»Atta...l Mate... | @Query...l @Explm...”ﬁTen"_ WMicro...l fﬁSnagl...l EsaL .. | |$ SR 0rM

D-1. Get Reports

When the Coordinator or User clickson “View TASS Reports’ link, alist of
contract numbers and project numbers assigned to the Coordinator or User will be
presented. The Coordinator or User selects a contract number and project number
and clicks on the “submit query” button for alist. A typica contract and project list
is shown next.
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Tenant Assessment Subsystem
Internet Reporting Facility

Below ate the Contract Numbers and Project Mutnbers for which you have acccess.

Please select either a contract number or project nmumber to quety the TASS database. [«\s
User: MI1111
Select Contract Mumbers: Select Project Numbers:
012028MNISUP & 012028M1  a
012143NIRAP 01211073
AZ168023001 07127143MI
CATB000G00S 012EHE2T
CA160033001 01335055
CT26H037074 01600007
MNJ38H085001 01611006
MY 020001001 01644066
NY020006004 016581010
Nyozoo06007 7] n1eg1011 x|
Submit Query |
Iain Menu
Back to Secure Svstemn
|3 == | Dacument: Done = R |
Eﬁﬁtartl !»Atta...l Mate... | @Query...l @Explm...”ﬁﬂue_" WMicro...l fﬁSnagl...l EsaL . | i@ SR 11 PM

This option alows the Coordinator or User to review only contract and project numbers assigned to
them. After choosing the option, the Coordinator or User will be presented with a screen ligting the
available Income Discrepancy Reports and Benefit History Reports for recertifications due. A
typica report list is shown next.
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Monthly Reports for Contract Number AZ168023001.

Select a Report to view:

Income Discrepancy Reports Eenefit History Reports
for recertifications due: for recertifications due:

August, 1995
August 15899 September, 1999
Cetober, 1959 Qctober, 1999

Decernber, 1999 Movernber, 1998
December, 1958

In order to print vour Benefit History Repotts on individual pages by fatnily, you will need to download a special u
HTWL-Scizsor. You will only need to dowrnload this utility one time.

Windows 95 users download this printing utility.

Windows 3.11 users download this utility. [%
I Repart Guery " Main Menu I‘

E@l | Document: Dione Doy
iﬁSlalll !»Atta...l Mate... | @Guer}l...l @Explor...”%ﬂue_" WMicro...l fﬁanagI...l [E5 500 .. | WA

The reports are grouped by type and presented in order from the newest to the
oldest. A report may be viewed by clicking the button listing the month and year of
the desired report. Reports are for re-certifications due in the month listed on the
buttons.

For efficiency and ease of handling, large reports have been divided into multiple
parts. Smaler reports have not been divided. If areport has been divided a screen
ligting dl parts will be presented as follows.
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Report Type [Benefit History Report

[Contract Mumber |cT26HD37074

Date [1999/08

The above requested report has been divided into multiple parts %r efficiency and ease of handling.
You will need all parts to hawve a complete report.
Part] Partd
Report List | Report Query l Wain Merm
|3 == [Document: Done = -
i || Starli !,»Atta...l Note... I @Quer}l...l 2] EHpIor...”ﬁ List ... EFMicro...! Eﬂanagl...I 5oL ... ’ [g&?‘;

It is not necessary for the Coordinator or User to download al report parts at the
sametime. Coordinators or Users may be reconnected to TASS at alater time to
retrieve other report parts.

If the report is divided in multiple parts, click on the part link (Part 1, Part 2, etc.) to
view that portion of the report.

The report will be displayed. Thetime it takes to display reportswill vary with the
speed of the user's Internet connection, and the size of the reports. Users only need
to access the TASS Internet gpplication once amonth so the time involved will be
minimd. At thistime, the user has the option of printing the report. 1n order to save
time, and to prevent the need to download the report again, HUD recommends that
Benefit History and Tenant Income Discrepancy Reports retrieved viathe TASS
Internet facility be saved to the user's locd disk for later viewing and printing.

After retrieving areport the user should choose the "Save as..." option from the
browser's File menu. The standard File Save didogue box will be presented. The
user will then navigate to the directory where the reports are to be saved.  Files can
be saved with the same name that appears at the prompt. If the coordinator or user



does not wish to have a previoudy file saved with the same name to be overwritten,
be sure to give the current file ameaningful name, eg. 10_1999B.htm.

Users may find it helpful to create the directory that will contain the saved filesin
advance of downloading reports.

All Coordinatorsand Usersmust be awar ethat onceareport is saved to
their local disk, it isnolonger in HUD's secure environment. They must
take precautionsto prevent accessto thereports by unauthorized
individuals.

Report contents may aso be searched by selecting the " Search™ option from the
"Edit" menu. A portion of asample Benefit History report is shown next.

T
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b B

EBENEFIT HISTORY REFORT FOR (RE)CERTIFICATIONS DUE [1999/11]

TRACS ID: TRACSII999TRACEIIING OvmerfAgent: F.E. WANAGENMENT Subsidy Type: H3
Project #: 1999051 Contract #: Unit #: CONF7P
REGFO Code:02/01 Project Name: AR YLAND PLAZA
Head of Household JOHN EMITH [For Reference Only]
58N 099-99-9999 Address:
Family Member JOHN SMITH [Information below applies to this farnily mer
SSN 990-99-9999 DOR: 04/06/1918
Social Security Data: Dual Entitlement Data:

Payment Status Code: C - Current Payment Status Payment Status Code: DE data not applicable

Date of Current Entitlement: 04/1980
Net Monthly Benefit if Payable: $242.00

Benefit History
Date Gross Benefit
12/1998 $243.00  Credited
12/1997 $233.00 Credited
0741997 $234.00  Credited
Buy-in
Medicare Data Premium Buy-in Start Start
Hospital Ins: $0.00 N
Supp. Med. Ins.: $45.50 Y 07/1937
Payee Name and Address:
JOHM SMITH
10 MARYLAND PLZ
APT 99
<N'F'H.f [ i
[ == | Document: Done S oE



A sample Income Discrepancy Report is shown next.
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Bl R __/

U.5. DEPARTMENT OF HOUSING AND URBAN DEVEL OPMENT
OFFICE OF HOUSING
451 SEVENTH STREET, 5.3.
WASHINGTON, D.C. 20401-5000
SOCIAL SECURITY AND SUPPLEMENTAL SECURITY INCOME
TENANT INCOME DISCREPANCY REPORT
FOR (RE)CERTIFICATIONS DURING THE MONTH OF [1999/11]
**FOR OFFICIAL USE ONLY**

Number of Families Included in This Report: 1

TEMAMT [NCOME DIZCEEPANCY FEEFORT
FOR (RE)CERTIFICATIONS DURING THE MOMNTH OF [1999/11]

TRACS ID: TRACE99999TRACS09999 Ovmer/Agent: R E MANAGEMENT Subsidy Type: H3 Proje
REG/FO Code: 02/01 Project Name: MARYLAND PLAZA Contract #: Unit &
Head of Household SMITH, JOHN
SSN: 999-99-9999 Address:
Monthly
----Family Member---- Prsn Income Monthly -Income Reported by
SSN Name DOE Type Sowrce -Income Reported to HA-  8S DE ;
990-00-2930 SMITH, JOHM — 04/06/1918 H 51 $0.00 $o0.00  $0.00 BT
999-09-3939 SMITH, JOHM — 04/06/1918 H 35 $232.00 $242.00 %000 B
Sub Total $238.00 $242.00 3000 $2
4] |
@I’#Tﬂ | Diocument; Done

Reports that consst of multiple parts will have navigation buttons

included to dlow the Coordinator or User to access the next or previous parts. The
parts do not have to be downloaded in order. A sample screen showing the
navigation buttons is shown next.
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Social Security Data: Dual Entitlement Data:
Payment Status Code: N - Dizallowed Claim Payment Status Code: DE data not applicable
Supplemental Security Income Data:
Payment Status Code C01 - Eligible for Payments
Alien Indicator: A
SSI Monthly Assistance Amount (Current): ~ $500.00
State Supplement Amount (Current): $87.00
Payment History of Net Benefits Paid:
Date Federal Amt State Amt  Type of Payment
01/0141999 $500.00 $87.00 Recurring Payment
01/0141998 $494.00 $86.00 Recurring Paytnent
Payee Name and Address
JIM SMITH
20 VIRGINIA PLARA
APT 66
BRONX NY
Black Lung Entitlement: $0.00
Disahility: Tes
Report Date: 09/28/1999
Part 3 of 6
| Prewvious Feport Parts List | Mezt
| Feport List Report Query | WIain Denn
1] |
| == | Dacurment: Done = TS

D-2 Viewing Saved Reports

To view reports that have been saved, users should firgt launch their web browser.
Choose the "Open’ or "Open Filein Browser" command from the File menu. The
gandard file didogue will enable navigation to the file to be reviewed. For best
results when viewing and printing monthly reports, the browser's font size should be
st t0 9. This parameter can be set in Netscape Navigator by choosing "Generd
Preferences’ from the Options menu. Click on the "Font" tab and click the "Choose
Font" button. Sdect "9" from the Size pop-up menu. In Microsoft Internet Explorer
the font size can be set by choosing "Fonts..." from the View menu. Sdect "Smdl”

from the pop-up menu.

D-3 Printing Saved Reports

Benefit History and Tenant Income Discrepancy Reports opened in the browser may
be printed smply by using the "Print" command from the browser's File menu.
Tenant Income Discrepancy Reports should be printed in landscape mode. Benefit
History Reports should be printed in portrait mode. The layout mode is set by
choosing "Properties’ in the print didogue box that gppears when the print command



ischosen. Current web browsers do not support the printing of individua pages. To
facilitate the printing of Benefit History Reports on separate pages for each individua
family, HUD recommends that users download a HUD-provided software utility
caled HTML-Scissor. Thiswill dlow the reports to be printed with each family on a

separate page.

HTML-Scissor can be downloaded from the TASS Internet facility. The utility will
only haveto be downloaded once. After logging on to the TASS Internet facility,
perform the following steps to download HTML - Scissor.

Deletetheold Hscissor files, if any.
Go to the Reports list screen.

To download the utility, select the link labeled "download this Printing Utility
here."

The standard File Save didogue will be presented. Navigate to the directory in
which you wish thefile to be saved.

To savethefile, sdlect "Save As Type - All Files” Click "Save."

Use the File Manager or Windows Explorer to navigate to the directory that
contains the downloaded file,

Double click on the sdlf-extracting file Hscissor or Hscissor.exe.

The user will be prompted for alocation in which to save the extracted files.
Enter the directory namein which thefiles are to be saved. Click the "Unzip"
button. After the files have been extracted, exit the unzip utility.

To launch the printing utility, navigate to the directory in which the extracted files
were saved. The user will then double-click on the file named Hs32.exe. The
goplication is pre-configured by HUD to facilitate the printing of Benefit History
Reports. After the gpplication is open, follow these steps to view and print the
reports. A sample screen showing HTML-Scissor is shown next.
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A HTML Scissor
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Slol|n]  alwle] [ o e [

BENEFIT HISTORY REFORT FOR (RE)CERTIFICATIONS DUE [1999/11]

TRACS ID: TRACII9I0OTRA CEIII00 Cwner/Agent: RE LIANAGELENT Subsidy Type: H3
Project #: 199990N] Contract #: Unit &:CONFTP
REG/FO Code:02/01 Project Mame:MARTLAND FLAZA
Head of Household JOHN SMITH [For Reference Only)
S5M: Do0_90.0000 Address:
Family Memnher JOHH SMITH [Infornation below applies to
55N 090909000 DOB: 04/08/1918
Social Security Data: Dual Entitlement Data:
Payment Status Code: C - Cutrent Payment Status Payment Status Code: DE data not applicable

Date of Current Entitlement: 0471980
Net Monthly Benefit if Payable:$242 00

Benefit History
Date Gross Benefit
1241998 $24200 Credited
1201997 $23200 Credited
071997 $23400 Credited
Buy-in
Medicare Data Premium Buy-in Start Start
Hospital Ins: $0.00 Iui
Supp. Med, Ins.: $45.50 T 07/1987
narnn Talnsmn need & ddwnoo.
J i
<::I Previous [= > Next

Please note: If your printer isset up to print a banner page between print
jobs, you must turn off thisfeature before printing Benefit History Reports.

Sdect "Open File' from the File menu.

The standard file open dialogue will be presented. Select *All Files under ‘Files
of type'. Navigate to the Benefit History Report to be printed. Click "OK"

The report will be split into sections by family with each family's report displayed
on asgparae page. The user may step through the individua reports by using
the Previous and Next buttons at the bottom of the screen.

Choose "Print All Pages' from the File menu to print al of the pages in the report
at once.

Usethe "Previous' and "Next" buttons to navigete to the specific pages if
desired.

Choose "Print Current Page" from the File menu to print only the displayed page.



TheHTML-Scissor application is pre-configured for the viewing and splitting
of Benefit History Reports. Users should not change any settings or
configuration optionsin the application.
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